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77Tutorial xxxxxxxxx

Tutorial
[illustration] www.acceptandproceed.com

Follow this step-by-step guide to creating a clever pamphlet 
which can be used to showcase your work…

77Tutorial Design a portfolio magazine

A
long with a well-presented portfolio, a 
promotional magazine containing your work can 
be an invaluable item for any freelance designer 
or design company. Use it as a way of making a 

fi rst contact with a prospective employer or client, or as a 
reminder of your work after a portfolio presentation. It’s 
imperative that this type of item looks great and showcases 
your work well, because the recipient will regard this as the 
kind of work you’re capable of. Attention to detail is crucial.

Designers are notorious for fi nding it hard to design these 
types of items for themselves, so our advice is to treat it as 
though it were a job for a client, by writing yourself a project 
brief with objectives, schedules and budgets. This will help 
you to be more objective about what it is you’re producing.

We’ll be working with an A2 poster-sized format that 
folds up into an A5 pamphlet, using a clever cut in the middle 
of the page. This format enables you to have a large A2 area 
inside to show off your work, which folds up into a magazine 

with a front and back A5 cover and three A5 double-page 
spreads. We’ll be preparing the magazine for professional 
printing, but if you’d rather use an A3 home printer, the 
format can also be downsized to an A3 which then folds 
down to an A6 postcard-sized pamphlet.

We create the artwork for our pamphlet using InDesign 
CS2, because the program allows us great control of text and 
grid. InDesign fi les are also fast becoming the preferred 
choice for printers. Throughout the process of designing this 
magazine we show you how to create a page and grid, set 
text, import and arrange images, and touch on how to specify 
die-cuts, an extra colour and folds. 

If you intend to use this magazine as a mailout, the fi nal 
stage will be to decide on who you send it to. This will vary 
widely depending on what type of work or job you’re going 
after, but one thing to remember is to always follow up with a 
telephone call to check if it has been received and whether 
a face-to-face meeting is possible.

Expertise provided by David Johnston at  Accept & Proceed. See more of his 
work at www.acceptandproceed.com

You’ll fi nd three InDesign documents on the Computer Arts Projects CD84, 
each showing a different stage of this project. Go to the DiscContent\
Tutorials\Tutorial Files\InDesign magazine folder.
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Whenever you’re 
working with a 
layered document 
with a coloured 
background it’s easy 
to miss slight 
differences in 
colours, but these 
are noticeable once 
your document is 
printed. So double-
check all document 
backgrounds are the 
same. We’ve chosen 
a CMYK black at 
C:30, M:30, Y:30, 
K:100 – a bold, 
dense black.

Colour match

It’s always best to 
name and save your 
document as soon 
as you’ve created it, 
because even 
though the InDesign 
software is very 
reliable there’s 
always the risk of 
the program 
crashing and you 
losing your work. 
We recommend 
naming and saving 
your document after 
Step 5, and then 
saving at regular 
intervals thereafter. 

Saving work

Tutorial Design a portfolio magazine

Part 1: Getting started 
Here are the basics steps for setting up your document in InDesign…

Part 2: The grid
Set up your basic grid – this is the backbone of your design...

1
Our portfolio magazine will fold 
down from A2 to A5. Split the page 

into four sections vertically and in half 
horizontally. The width of the page is 
594mm, so the fi rst fold will be a quarter 
of this amount in from the left. Drag a 
guide from the left ruler to 148.5mm.

2
You can also specify where the 
guides sit using the Control panel in 

the top left of the screen. The next two 
vertical guides should sit at 296mm and 
445.5mm, and the horizontal guide goes 
halfway up the page at 210mm.

3
Now you need to draw the grid over the guides for each page of the magazine. 
We decide to allow a 7.5mm space around each of the folds, so set some more 

guides to mark out these areas. You can do this using the rulers along the top of the 
document or by checking the guide locations in the Information panel. You should 
already have set up the 15mm guide around the outside when you opened the 
document, so you don’t need to worry about that. 

4
Further down this window is the Bleed option, where you 
can specify the amount you want material to bleed off 

the edge of the page. Enter an amount of 5mm, and then click 
the lock button.

5
Click OK and you’ll see your 
document set up inside the 

InDesign interface. The InDesign palettes 
are all stored down the right-hand side 
of the screen, and they can be opened 
and closed with a mouse-click.

6
The palettes stored here control the pages and layers, and 
also show document information. Below that you have 

stroke attributes, colour, transparency and gradient controls. If 
you’re new to InDesign, take a few moments to familiarise 
yourself with these palettes – you may see some similarities 
between these and other Adobe programs.

1
The fi rst thing to do is go to the File menu and choose 
New>Document. A window appears, into which you 

need to enter the specifi cations of your document.

2
For the moment, we’re going to set the number of pages 
to one, because we can add extra pages later. It’s also 

best to deselect Facing Pages at this stage. There’s a selection 
of preset page sizes, but we’re going to go for A2 size. Enter 
594mm width and 420mm height.

3
For now, you can leave the Columns and Gutter settings 
at default, but you need to specify the Margins. InDesign 

CS has a new feature which enables you to lock together your 
Margin settings, so all you need to do is key in 15mm to the 
fi rst box and click the lock icon to change all the other settings.
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As in any creative 
application, there 
are many keyboard 
shortcuts in 
InDesign to help 
speed up the design 
and layout process. 
One of the most 
useful time-saving 
functions is using a 
single key to change 
tools rather than 
having to select the 
new tool in the Tools 
palette. A full list of 
InDesign shortcuts 
can be found within 
your Adobe Help 
centre, so see what 
works for you.

Shortcuts

79Tutorial Design a portfolio magazine

4
Before you go any further, take a moment to name the 
layer that you’re currently working on. Open the Layers 

palette on the right-hand side of the screen. Here you’ll see 
that the layer has been called Layer 1 by default. Double-
clicking on this will bring up the Layer Options window. Name 
this layer: Background.

5
Now we want to set up a black background for our 
document. Use the Rectangle tool to simply drag a 

rectangle from the top-left bleed guide, which is marked in 
red, down to the bottom right-hand corner. You can see in the 
information area at the top of the screen that the size of this 
box is 604x330mm.

6
Now fi ll this box with black by clicking on the Colour 
palette lower down on the right-hand side and entering 

100 per cent into the K (black) box. Leave the other colours as 
0 per cent. If the CMYK slider isn’t showing, you can bring this 
up by clicking the little arrow on the top left of the Colour 
palette, and selecting CMYK.

1
The fi rst thing to do is create an image layer. Open a 
new layer in the Layers palette and name it Images. This 

is the layer on which all the images will be placed. Click on 
this layer, go to File, and then Place. Then select the image 
you want to place by locating it on our hard drive, selecting it 
and clicking Open.

2
You’ll see that your cursor is now charged up with a 
graphic content icon. This icon changes depending on 

whether you’re importing images or text. Drag out a box to 
the size of one page of the magazine. Notice that the picture 
box is the correct size but the dimensions of the image you’ve 
imported isn’t quite right.

3
Go to the Tools palette and select 
the Direct Selection tool (the white 

arrow). You can now select the image 
within the box, move it around, and 
resize it to fi t the box. Hold down the 
Shift key to restrain the proportions.

Part 3: Importing images
You’ll need to import images of your work whatever format you use for your magazine… 

4
If you need to be exact with your image sizes, you can 
also resize the image using the Control panel at the top 

of the screen. There is a lock icon next to the measurements, 
which can be selected if you want to constrain the 
proportions of the image. This has the same effect as 
holding down the Shift key while resizing an image with 
the Direct Selection arrow.

5
The images of your work are the most important thing in 
this piece of design, so their presentation is crucial. You 

need to show the image as large as possible without making it 
look cramped. We’ve chosen to show the work white out of 
black because it’s strikingly difference from the norm. Ensure 
that whatever colour you choose doesn’t detract from the 
work you’re showing in any way.

6
As well as showing your actual work, it’s also worth 
including an image of it in context. For example, if the 

image has been used on a billboard then show it on a 
billboard. Likewise, if you’re showing a letterhead design, 
show a photo of the printed piece. Here, we show a T-shirt 
design used to good effect. Displaying the realised piece 
adds credibility to you work.
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It’s worth remembering that your portfolio magazine will act as an 
example of the standard of work that you’re capable of, so mistakes are 
unacceptable. Try to put yourself in the mind of someone who is viewing 
your work for the fi rst time and ask yourself if its presentation is the best it 
can possibly be; if it’s not then why not?

Show your best pieces

Tutorial Design a portfolio magazine

4
If you click in this box with the Type tool, it becomes a 
text box. Now type in the information you require. 

We’ve decided to keep these details simple, just stating that it 
contains some examples of your work, along with the date on 
which this magazine has been produced. Initially, this text will 
be set in the default font and size, but over the next steps you 
can style it to your particular requirements.

5
If you want the text to sit in two 
columns on the front page, go to 

the Object menu and select Text Frame 
Options. Select the amount of columns 
and the amount of space between the 
columns: the gutter. Clicking the Preview 
box in the bottom left of this window 
allows you to see the changes as you’re 
making them.

6 
We set all the text in caps in Avant Garde at 16pt with 15pt leading, and 8pt 
for the smaller text. You can select a different case for your text – choose 

between upper case, lower case, title case and sentence case by going to the Type 
menu and selecting Change Case.

Part 4: Formatting type
Information about your work and your contact details should be clearly laid out, and easy to read…

1
First, we import the text for the front cover. We’ve designed this logo for 
Johnston & Dragons in Illustrator, because the program allows more freedom 

and control for creative type than InDesign does.

2
The logo has been designed to fi t 
to the exact size of the page, and 

it’s been saved as an .eps fi le so that 
when we import it, it’s already the 
correct size. The size of text can 
sometimes be deceptive on screen, so it’s 
well worth doing some test prints so you 
can see how big the type is going to be 
once the magazine has been printed. 

3
Now you need to write the title of your magazine on the 
front page. Another essential element needed is your 

contact details on the back cover. If you have information like 
this already written in another fi le format, say as a Word 
document, you can import it in the same way as you would 
import an image. In this instance, we’re going to type the 
information by hand, so we begin by creating a box within the 
grid using the Rectangle tool.
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6
You also need 
to consider 

what kind of 
paper stock you’d 
like to use, or you 
could go for a 
special print fi nish 
such as a UV, 
spot varnish, 
emboss or a fi fth 
spot colour. These 
processes can 
really make your 
magazine come 
alive, and can be 
set up in the same 
way as the die-cut 
and folds.

If you want to use a 
special fi nish on the 
cover, or throughout, 
your magazine, it’s 
essential that you 
talk to your printer 
early in the process.  
Using Pantone 
colours, foil blocks 
or opting for a die-
cut treatment will 
add to the cost and 
the printing time. 
You’ll also have to 
work to particular 
specs and delivery 
instructions to 
ensure that you get 
exactly the result 
you’re looking for. 

Special 
treatments

81Tutorial Design a portfolio magazine

4
A die-cut is 
shown in the 

same way, by 
adding an extra 
layer and naming 
it Die-cut. Here, 
it’s simply a cut 
down the centre 
of the poster that’s 
needed, but die-
cuts can be fairly 
intricate. Send 
artwork of your 
intended design 
to your printer so 
you’ve got time to 
consider any 
comments they 
might have.

5
We make 
things 

completely clear 
for the fi nishers 
by drawing this 
diagram showing 
how the folds 
work. Although 
not essential, this 
kind of instruction 
can be helpful to 
the printer and 
should prevent any 
mistakes – the last 
thing you want is 
for the magazine 
to be printed 
back-to-front.

1
When you’ve fi nished the artwork, make sure you check everything. Check for 
any spelling mistakes or extra spaces in text. Also check that you’re happy with 

all the sizes, that all colours are consistent and that any images that bleed off the 
page hang at least 3mm over the outside of the document.

2
If you want to use a Pantone colour to give your magazine that extra special 
fi nish, open the Swatches palette (Window>Swatches). Click the ‘more options’ 

arrow in the top left and select New Swatch. In the New Swatch window you’ll fi nd 
the option to select the Pantone colour of your choice.

3
Setting up a fold line in InDesign is easy. Simply add a new layer and call it 
Folds, then draw lines where you want the paper to fold. You can see these 

lines highlighted above in pink.

Part 5: Adding extras
Specify a die-cut and folds, and decide if you want to use an extra colour …
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You’ll need to put 
some effort into 
compiling a list of 
people to send your 
magazine to. You 
can get names of 
the people in 
charge of 
purchasing 
commercial art or 
employing 
designers by calling 
the company 
directly. And a few 
days after your 
prospective client 
has received the 
brochure you should 
contact them 
requesting a 
meeting to talk them 
through your work, 
and discuss what 
you can do for them.

Contacts

Tutorial Design a portfolio magazine

Part 6: Printing
The fi nal step is to set up your magazine for print… 

1
If you’re going to have your magazine printed professionally, it’s best to deliver 
the artwork to your printer as a PDF. You can create this by exporting your 

document directly from InDesign. Go to File>Export...

2
In the Export Adobe PDF dialog you can fi nd out if your images are currently 
at a larger resolution than needed. If so, you can downsize them in the 

Compression setting. Usually printers print at 300dpi, but some can print at higher 
resolution – make sure you check with your printer before preparing your artwork.

3
Once you’ve 
exported 

your pages, open 
the PDF in Adobe 
Acrobat Reader 
and check how 
your print-ready 
document looks. 
This is where you’ll 
see if there are any 
discrepancies in 
colours. Preview 
individual plates 
such as the C, 
M, Y or K plate 
and go to the 
Advanced menu 
and Output 
Preview for any 
extra colours.

4
If you’re 
going to print 

your magazine 
using an A3 home 
printer, you can do 
so by reducing the 
artwork from A2 
to A3. This way 
your magazine will 
fold down to 
postcard size –
handy for posting. 
You might want to 
make the poster 
the envelope itself, 
by applying a 
stamp and writing 
the address 
directly on to 
the cover.

5
Once you’ve 
fi nished 

creating your 
magazine, you’ll 
need to decide on 
who you’re going 
to send it to: the 
press, clients, job 
advertisements, or 
elsewhere. It’s a 
good idea to hand 
write the address 
on the envelope, 
because people 
always open 
hand-addressed 
mail fi rst.

6
Once you’ve 
sent out your 

promotional 
brochure there’s 
one more thing to 
do: follow it up by 
calling to check 
that your 
prospective client 
or employer has 
received it. Use 
this call as an 
opportunity to 
try to arrange a 
meeting so you 
can present your 
portfolio.  ca p
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Ex-Red Designer David Johnston has recently set up his own creative 
venture: Accept & Proceed. Never has his portfolio been more important…

BACKGROUND:
Johnston studied Graphic Design at Central 
St Martins, graduating in 1999. He then 
worked at the fashion brand management 
company Overland in London on brands 
such as Caterpillar and Paul Smith, also art 
directing a new identity for the fashion 
brand Stride. Following this he worked for 
Interbrand, the world’s leading branding 
consultancy at its Amsterdam offi ce, and 
then as a Senior Designer at Nike European 
HQ in Hilversum, Holland. Finally he did a 
two-year spell as Designer and Art Director 
at Red Design in the UK, working on all of 
the agency’s major projects. Johnston 
recently left Red to set up his own personal 
venture: Accept & Proceed.

YEARS PRACTISING AS A CREATIVE;
Eight.

CLIENTS:
Audio, Dazed and Confused, Delicious, 
Nike, Penguin, Smartcar, University of
the Arts London, 180.

FAVOURITE TOOLS:
Photoshop, 3ds max, Poser.

MISSION STATEMENT:
• Connect and recognise.
• Formulate and compose.
• Amend and establish.
• Advance and delight.
• Accept and Proceed.

WEBSITE: 
www.acceptandproceed.com

Expert profi le: David Johnston

Left: Promotional poster 

for Albino Promotions /  

International Digital Art 

Exhibition, to be held in 

London UK & Dubai 

world trade buildings.

Below: Identity for Nike 

International: Future 

Golf Project, due to be 

launched in spring/

summer 2007.

Bottom: Three CD 

sleeves for the 

Swedish electro artist, 

Daseldorf. Independent 

release 2006.
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